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DISCLAIMER - AGREEMENT
Users of WinTel must accept this disclaimer of warranty:

WinTel is supplied "AS IS".  The author disclaims all warranties, expressed or implied, including, without 
limitation the warranties of merchantability and of fitness for any particular purpose. The author assumes 
no liability for damages, direct or consequential, which may result from the use of  WinTel.

WinTel is a "shareware program" and is provided at no charge to the user for evaluation.  Feel free to share 
it with your friends, but please do not give it away altered or as part of another system. If you find this 
program useful then you must register. The registered users would be provided with a  disk and a printed 
manual.  The disk also contains an installation program. Please read wintelrg.wri for more info on 
registration. The registration will license one copy for use on any one computer at any one time.  You must 
treat this software just like a book.  An example is that this software may be used by any number of people 
and may be freely moved from one computer location to another, so long as there is no possibility of it 
being used at one location while it's being used at another. Just as a book cannot be read by two different 
persons at the same time.

If you have any suggestion or have any bug to report, please send me an email to:

If you have any suggestion or have any bug to report, please send me an email at:

internet:
74243.3047@compuserve.com
CompuServe ID : 74243,3047

System Requirements

* You  must have Microsoft Windows, version 3.1 or higher. A 286, 386 or 486 based PC with a 
mouse and a hard drive.

* Your computer must have at least 2MB of memory.
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* A modem is required to dialin to a remote system. If you need to connect to computer in the same 
room then a null modem cable is required.
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This user's guide is organized as follows:

Section 1 outlines WinTel’s features.

Section 2 explains you how to install this program.

Section 3 explains you how to connect and disconnect to a remote system.

Section 4 deals with modifying keyboard, color, modem, communication, terminal and font  settings.

Section 5 explains you how to send and receive file from a remote system.

Section 6 explains you how to view a GIF/JPEG file in realtime and offline mode. Also how you can 
uuencode and uudecode an internet file is explained.

Section 7 explains you how to write a script language to automate your logins.

Section 8 deals with copying and transmitting text from the clipboard. Printing and session capturing is also
explained.
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Introduction
WinTel is a full featured communication software that connects you to other computers. Following features 
are included:

* Phonebook which stores your remote service names, phone numbers and communication settings.

* Telnet client to remote host using TCP/IP (SLIP/PPP) connection.

* File transfer using ASCII, xmodem, xmodem 1k, ymodem batch, zmodem and kermit protocols.

* A realtime and an offline GIF/JPEG viewer.

* DEC VT100, VT52, VT100 (ANSI Color), TTY and a raw mode terminal emulation.

* Redialing and batch dialing capability.

* Programmable script language which automates your logins to remote system.

* Chat mode, which lets you talk to the user at the remote end.

* Resizeable fonts, scroll back buffer, printing and session capture.

* uuencode and uudecode internet files.

* Run multiple instances of this application.
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Section Two
Installation

To install WinTel, select the Run command from the File menu of the program manager. In the command 
line box, type in A:\install.exe or B:\install.exe as the case may be. Press Enter key. An installation dialog 
box would appear. You would be asked for the directory name where you want WinTel files to be copied or 
just select the default directory. Click on OK. The installation program would  inform you once it is 
complete.
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Section Three

Connecting

You can start WinTel in one of the following ways:

a) Double clicking on its icon .
b) Selecting Run command from the File menu of program manager.
c) Selecting Run command from the File menu of the file manager.

Open phonebook by selecting phonebook command from either the File menu or toolbar. Your login 
session is started by either double clicking an existing entry or by selecting an existing entry in the name 
listbox and then clicking on the dial button. A dial window would open up showing you the phone number 
dialed. You can cancel the dial operation by clicking on the Cancel button. The system will inform you 
once the connection has been established.  If you want to dial in batch mode then enable the dial batch 
check box in the phonebook dialog box. Double click on entries which you wish to be added to the 
batchlist. Once you have added all your desired entries to the batchlist, click on the dial button. The system 
will batch dial until a connection is established. 

In order to add a new entry to the phonebook, click on the New button in the phonebook. A Communication
setting window would open up. You must already know your required settings for the remote computer 
with which you want to communicate. Most services publish their communication settings as: 2400,8,N,1. 
This indicates a 2400 baud modem speed, 8 data bits, no parity and 1 stop bit. If you do not know the port 
where modem is connected then click on the default setting button. This program will figure out the port 
and make following settings for you:

Baudrate
2400
Databits
8
Parity
None
Stopbit
1
Flow Control
Both hardware (RTS/CTS) and XON/XOFF
Phonetype
Tone
Port

Port where your modem is connected.
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Terminal
VT100 (Ansi Color) with auto wrap
File transfer Protocol
ZMODEM 
Modem
Hayes compatible
Retry dial count
5
Connect timeout
60

You make entries to the online service name and its phone number. You may however change the default 
baud rate of 2400 to whatever connect speed you desire.

Phonebook button description

Here is a brief description of all the buttons in the phonebook:

Cancel
Removes the phonebook from the display.
Dial
Dials a selected entry or batch dials.
New
Adds a new entry to the phonebook.
Delete
Deletes a selected entry from the phonebook.
Copy
By clicking on this button you would invoke copy service dialog box. you can copy all the settings of an 
existing entry to a new entry. Following controls are provided:
Service name
Here you type in your new service name. 
Phone number
Here you type the phone number of new service. 
Phone prefix
Phone prefix is a number which modem must dial before it dials the actual number. For example many 
PBX systems require you to dial “9” to obtain a outside line. In this case you would be entering “9,” in the 
phone prefix field.
Autologin
Executes the Script for the selected entry.
Options
This would open up dial options dialog box. Here you can specify following fields:
Retry dial count
If you attempt to connect and connection fails (busy line or no reply etc.) then the program would retry to 
connect. The default number of retries is set to 5 but you can change this field by typing in new number in 
retry dial count edit box.
Timeout
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This field tells the system how much time the program should wait for the connection before it times out. 
The default is set to 60 seconds. But you may modify this field by typing in the new value in the timeout 
edit box.
Batch Dial
By enabling this option, you can dial numbers stored in the batch list. You make entries to batch dial list by 
first enabling the batch dial. A check mark would appear when enabled. You double click on service name 
listbox entries. The double clicked entry would be added to the batch list.
Remove
You can delete a batch dial entry by first selecting it and then clicking on the remove button. 

Hardwire/Answerback mode

If you want to connect your computer to another computer in the same room or you want the other 
computer to dial in to your computer, then you must first establish a communication channel. You do this 
by making an entry in the phonebook. Follow same steps as you do when you add a new entry to the 
phonebook but leave the phone number field in the communication settings dialog box as empty and set the
phone type field in the communication setting dialog box as none. Click on the dial button. Your 
communication channel would open up.

Chat Mode

With this option you can chat with the user logged onto a remote computer.  When you make this selection, 
your window will split into two halves. The upper window will display the text you type in and the bottom 
window would show you the response from the remote user. Before you can commence chatting, you must 
first establish a connection.  This can be done either your dialing  in to his/her system or wait for a call 
from the other end. If the other end wants to dial in to your system, you must first open your 
communication port. Use the phonebook, make an entry in the communication setting dialog box with no 
phone number and phone type field set to none, then click on the  dial button. This would open up the 
communication channel. From the option menu enable the "Answer " command and then wait for the call. 
However, If this option is disabled, then any incoming call would result in a "RING" text on your screen. 
You type in "ATA" and the connection would be established. Enable the chat mode if you have not already 
done so. Now you are ready to chat.  Disconnect the connection by choosing "Hangup" command from the 
session menu or from the hangup button in the toolbar.

Disconnecting

If you want to disconnect from a session, you must first hangup. This is done by selecting "Hangup" 
command from the session menu or clicking on the hangup button in the toolbar. You may then either exit 
from the program or dialin to another service. You exit the program by selecting Exit command from the 
File menu or clicking on the exit button in the toolbar.

Telnet Client
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You can connect to internet using Telnet. This allows your computer to talk to the remote
host using TCP/IP protocol. Before you can telnet to your host computer, you would
require a TCP/IP stack and if you are using your modem to dailin to your remote computer, you would need
a internet dialer talking SLIP/PPP protocol. If you are running
under Windows 3.1 environment, you would need to get the shareware program Trumpet Winsock. 
However if you are running under Windows 95, it already has a TCP/IP stack and an internet dialer. Once 
you have established a connection to internet either using Trumpet Winsock or Windows 95 dialup 
networking, you are ready to telnet to the remote host. 

Double click on the Telnet icon in WinTel program group. A Telnet phonebook would open up. You can 
create entries to the phonebook by clicking on the new button. A communication dialog box would appear. 
You type in the phonebook entry name in the name field and in the address field you type in the internet 
address of the remote host.
If for example, you wish to telnet to CompuServe, then the name field, you would enter Compuserve and in
the address field, compuserve.com. The terminal setting and the the protocol buttons work exactly the same
way as in the modem connection described earlier.
Once an entry has been made, you can click on the connect button in the phonebook dialog box. This 
program would then attempt to connect. Make sure your SLIP/PPP connection has already been 
established. 
When you have established your connection, you can do file transfer using xmodem,
ymodem, zmodem and kermit. If you are transferring files, make sure you check the binary checkbox in the
communication setting dialog box. 
The advantages of using telnet over serial line connection is that you can have several sessions open at the 
same time. That is  different windows can communicate with different hosts at the same time. 
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Section Four

Settings

Note: All settings excepting that of scroll buffer length and batch dial  flag apply locally to a given online 
service.

Communication Setting

Communication settings dialog box can be invoked from the phonebook's edit button. This command 
allows you to define your communication parameters. Here is a list of options available to you:

Cancel
Removes the box from display
Name
Enter your service name. Any text following space or first eight characters is treated as a comment to the 
name.
Phone number
The phone number of remote computer.
Phone prefix
This field is required for an internal phone system to connect to an outside line or to wait for a dialtone. 
This usually is 9.
Baud Rate
Select the  speed of your modem. The most common setting is 2400 baud. You must set it to your modem’s 
baud rate. NOTE: If you have a modem with baud rate 14.4K and you experience problem connecting at 
14.4K, then you may select the baud rate of 19200.
Data Bits
Specify the number of data bits in each data packet exchanged between yours and the remote computer. 
This field usually is either 8 or 7.
Parity
Select the type of parity. Select no parity for 8 data bits and an even/odd parity for 7 data bits.
Port
Here you specify your communication port where you have your modem connected. This usually is either 1
or 2.
Flow Control
This selection specifies which action is to be taken when the incoming data buffer gets full. The default is 
set for both hardware (RTS/CTS) and XON/XOFF flow control.
Phone type
For touch tone phone select phone type as tone. For pulse dialing select pulse and for direct connection and 
manual dialing select none.
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Modem Setting

This option can either be selected from communication settings dialog box or from the settings menu. You 
select your modem by clicking on your modem type in the list box and then selecting OK.  If  you do not 
find your modem in the listbox then select a custom modem option. If you wish to modify modem strings 
then click on the select button. This would open up modem string setting dialog box. These strings in the 
dialog box enable WinTel to initialize, reset, dial and hangup the modem. Following is the description of 
modem strings:
Dial
This command places the modem in originate mode and dials a number and attempt to make a connection. 
The dial string is built from the command in the prefix string, P(Pulse) or T(tone) and the phone number. 
The default prefix string is ATD and the suffix string is a carriage return (^M). You may never have to 
modify this.
Hangup
The command in here forces the modem to hangup. The default string is ATH.
InitString
This is an initialization string which is sent to the modem. The default Hayes compatible string is 
ATS0=0Q0V1E1. Different modem vendors may specify their own initialization string. Consult your 
modem’s user guide. You may change it only in case you are experiencing problem with the initialization.
Reset
The string in here soft resets the modem. Reset restores the default factory setting or a stored profile 
setting. The default is ATZ
Escape
This is a sequence to switch modem from data mode to command mode. The default is 
<guard time>+++<guard time>. When you are connected to remote, you can type in +++ in succession and 
the modem would switch from data mode to command mode. You can reestablish the connection by typing 
ATO.
Valid dial characters
The characters in here are the valid characters in a dial string. However, you may add any dial modifiers not
found in here but listed in your modem’s documentation.
Result code button
When you click on this button, a result code dialog box would be displayed. These result codes enable 
WinTel to redial in case of an error. Following result codes are available:
Busy
This string is sent by your modem to your computer when the number you dial is busy. The default is 
BUSY
Dialtone
This string is sent by your modem when there is no dialtone. The default is NO DIALTONE.
Carrier
This string is sent by modem to your computer when there is no carrier. The default is NO CARRIER.
Answer
This string is sent by modem to your computer when there is no answer. The default is NO ANSWER.
Error
This string is sent by your modem to your computer if the command sent to the modem is invalid. The 
default is ERROR.
OK
This string is sent by your modem to your computer when the modem acknowledges a command. The 
default is OK.
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Timeout
This string is sent by your modem to your computer when modem timeouts while making an connection. 
The default is TIMEOUT.
Connect
This string is sent by modem to your computer when connection has been established. The default is 
CONNECT.

Terminal Emulation

WinTel can emulate most of the popular terminal types. Perhaps the most popular  terminal emulation used 
in the industry is VT100(ANSI). You select terminal preference either from the communication settings 
dialog box or from the settings menu. In VT100 and VT52 mode, your function keys F1 to F4 behave like 
those of DEC's PF1 to PF4. Keep the Num Lock key down to emulate the DEC VT100 keypad. Codes sent 
by numeric keypad 9 to . are same as those sent by DEC's VT100 terminal. Your PC’s insert key sends the 
same code as sent by keypad’s enter key on a VT100 terminal. To emulate BBSs graphic characters, choose
the terminal fonts from the fonts menu option.

WinTel also has a raw terminal emulation mode. This allows you to view all the characters sent by the 
remote computer. These include control keys. This feature is extremely useful in examining  the raw codes 
sent by the remote computer. 

Following options in the terminal preferences may also be selected:

Local Echo
This option is useful when the remote computer does not echo your typed in characters. This is the case 
when the remote computer operates in an half duplex mode. Do not make this selection as most computers 
operate in full duplex mode.
CR->CR/LF
Specifying this option enables carriage return and a line feed to be sent to the remote computer when you 
press an enter key . As most computers send you a linefeed, do not  select this option.

Buffer Lines
Here you specify the number of lines this program should save. The default is 200 lines. You may save upto
400 lines in the buffer for later viewing.
Terminal Width
Here you specify width of the terminal. The default is 80 columns.
Auto Wrap
Here you specify whether or not text wraps to next line when it reaches right margin. The
default setting is auto wrap as most of the BBSes assume.
Backspace -> Delete
Here you specify whether backspace character should be  treated as a destructive delete character or simply 
a backspace character i.e. cursor moves to the left without deleting the character. For ANSI terminal, by 
default, the backspace key is treated as a destructive delete key.
OK
Clicking on OK will save your settings.
Cancel
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Cancel will cancel all the changes you have made to the terminal prefs dialog box.

Keyboard
This command can be invoked either from Settings menu or from communication settings dialog box. You 
can examine keycode sent to the remote computer by clicking on the desired key. When you click on say an
arrow key, a dialog box displays the arrow and keypad sequence in application mode ( this mode is set by 
the host) sent to remote when you press any of these keys. The codes sent depend on the type of terminal 
emulation you have chosen. With the num lock key down, the codes sent by keys 9 thru “.” are same as 
those of DEC’s VT100 and VT 52 terminals. If you have chosen VT100 as your terminal emulation then 
page up/down key take you 1 page forward/backward while using DEC’s EDT and home/end key take you 
to the top/bottom of a file.
Here you can also define F5 to F12 for your purposes. Click on any function key F5 thru F12, a function 
key definition dialog box would be displayed. You make an assignment to the function key by typing in the 
string in the edit box. Remember to type “Enter” key as ^M. Similarly all control keys are prefixed by a 
caret ^. For example if you want to define key F5 as control-Z then you would enter ^Z in the edit box. If 
you want the definition to contain an escape character (ASCII 27) then you would enter ^[. 

Colors

This command can be invoked either from the settings menu or from the communication settings dialog 
box.
You can select color settings for the text and the window background by selecting color command from the 
settings menu for terminals other than VT100 (ANSI Color) terminal. For ANSI Color terminal, by default, 
light gray text is shown on the black background. Select the element and then choose the desired color from
16 predefined VGA colors. If these colors do not suit your needs then create your own colors with the help 
of three RGB scroll bars. By changing the red, green and the blue component  of a color, any desired color 
can be achieved. Once you have made your choice,  save them by clicking the OK button. You may revert 
back to your original window colors by clicking on the default button. 

Summary of Color controls:

Color Element Listbox
Here you specify the element whose color you want to modify.
Default
When you click on this button, the window text and the background color would revert back to default 
colors of the window.
Color Boxes
You click here to choose one of the 16 colors for your background and text.
Red, Green and Blue scrollbars
These three scrollbar controls would enable you to customize your color. You change the red, green and 
blue component of a color to obtain a desired color. The color thus obtained is displayed in a rectangle. The
RGB values are shown to the left of the scrollbars.

Fonts

You can select font command from the settings menu or from communication settings dialog box. A list of 
all fixed size fonts are shown in the listbox. A font is selected by clicking on the desired entry in the listbox.
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Font size is not shown as this program adjusts the size of the font based on your window size.

Default Directory

This command can be invoked either from the settings menu or from the communication settings dialog 
box. Here you specify the default directory for the file transfer and your session logs. If  the session log 
option is enabled then the log file would be stored in the directory you specify in the session log edit box. 
Your downloaded files from the remote system will go to the directory specified in the default download 
directory edit box.

Protocol

You select the file transfer protocol by first invoking the protocol dialog box from the settings menu or 
from the communication setting dialog box. Select the  desired protocol from the listbox. The default and 
the recommended protocol for file transfer is ZMODEM. You may  specify maximum number of errors 
allowed before the transfer aborts. The default value is 5. You can also specify if the system should make a 
backup file in case the file you are receiving has same name as the existing file. This however does not 
apply if in the ZMODEM protocol, you have selected crash recovery option.

ZMODEM Options
If you have chosen ZMODEM protocol, you may like to edit options available to it. Click on the options 
button. A zmodem options dialog box would be displayed. There are three check buttons in this dialog box. 
They are:
Send skip if file exists
If you are downloading a file and this file already exists in your directory and it is of the same size then the 
system would inform the remote to skip sending this file if this option is enabled. A check mark would 
appear when this option is enabled.
Crash recover
If you are downloading a file and this file already exists in your directory and the size of the file is smaller, 
then the system would inform the remote of sending the file starting from the current size of the file.
Segmented streaming
This option enables segmented streaming i.e. there are intermediate acknowledgments. This would slow 
down the file transfer. This option however is useful if you are storing your data say onto a floppy.
Escape control
This option enables all control characters to be escaped. This is useful if the network you are connected to 
does not pass control characters. For example, if you are telnetting to another unix machine and the mode 
of connection is ASCII, then by enabling this option, you would be able to do file transfer directly to your 
machine.
ASCII Options

If you opted for ASCII file transfer protocol. Click on the options button. An ASCII transfer options dialog 
box would be displayed. There are three items in this dialog box:

Strip linefeed when sending 
In a MS-DOS text file, a line is terminated by a carriage return (ASCII 13) and a line feed (ASCII 10). You 
enable this option if the remote system requires you to strip away the line feed.
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Character to initiate transfer
Remote system may require you to send a character to initiate ASCII file transfer. This usually is a carriage 
return. Enter that character in the edit box here.
Character to end file transfer
This is the character which remote computer sends to indicate the end of file transfer. You type in this 
character in the edit box.
Inter-line delay
Here you specify delay in millisecons after each transfer of a line in text. The default is no delay.
Inter-character delay
Here you specify delay in milliseconds after each transfer of a character. The default is no delay.

KERMIT Options

This dialog box appears when you click on the options button in the protocol dialog box and you have 
selected KERMIT protocol in the listbox. For the block check option, WinTel supports block check type 1 
and 2.

Following options are available:

Maximum buffer size
Here you specify maximum possible packet size for KERMIT. The maximum size allowed is 9024 bytes. 
However, your remote computer must be capable of sending and receiving packet of this size. The bigger 
the packet size, faster would be the file transfer. It is recommended that you use 1024 bytes as the packet 
size.
Eight bit prefixing
Enable this option if  your communication channel is 7 bit wide. 
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Section Five
File Transfer and Protocols

Once you have established a connection to the remote system. You can exchange text and binary files. In 
order to transfer files, you must first select a protocol which both your system and the remote system 
recognize. A text file is a file created by a text editor known as an ASCII file. A binary file is a file of any 
kind. This could be a bitmap image or an executable file. It is recommended that you use binary file 
transfer protocol for all your file transfers. This is due to the fact that  ASCII file transfer protocol does not 
do any error checking. For binary transfers, you may opt for one of the protocols described below:

XMODEM/Checksum
This protocol transfers data in 128 byte packets. It does error checking of the data with checksum. It is 
reliable but is slow because of the small packet size. Also it does not have a batch transfer capability.

XMODEM/CRC
This protocol transfers data in 128 byte packets. It does error checking of the data with 16 bit CRC. It is 
reliable but is slow because of the small packet  size. Also it does not have a batch transfer capability.

XMODEM (1K)
This protocol transfers data in 128 and 1024 byte packets. It is an extension of XMODEM/CRC. This 
protocol  is also known  incorrectly as YMODEM. This is not a batch protocol therefore only one file can 
be transferred per transfer.

YMODEM(BATCH)
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data blocks but in its first block it 
sends the filename, filesize and the file creation date. This protocol is fast, reliable and has a batch transfer 
capability.

YMODEM(BATCH -g )
Like XMODEM(1K), this protocol transfers data in 128 and 1024 bytes data blocks but in its first block it 
sends the filename, filesize and the file creation date. This protocol does not have intermediate acks and 
naks. Therefore it is more suited for the hardwired connection. This protocol is extremely fast but not 
recommended because a single error would cause the retransmission of the entire file. This protocol has a 
batch transfer capability.

ZMODEM
This is perhaps the most popular protocol today. It is fast because in can do full streaming, very reliable and
allows batch file transfers. Also it allows the transfer of partial files (known as crash recovery) in case  
transfer was aborted. 

KERMIT
This protocol is available for almost any operating system. This protocol would work over any 
communication channel as long as it is capable of receiving and sending printable ASCII characters. The 

17
17



18

maximum size of a packet in the original kermit is limited to 94 bytes. But with the extended packet option,
the packet size has been extended to 9024 bytes. This speeds up the file transfer. WinTel supports extended 
packet size option. 

Receiving Files

If  you want to receive files using ASCII, XMODEM or YMODEM Batch protocol. You choose receive 
command from the File transfer menu. This must be done after the remote system has informed you that it 
is ready to send you files. Once you have selected the receive command, you will be asked for a filename 
of the downloaded file in case of ASCII and XMODEM (All flavors) protocol.

If you have opted for YMODEM batch protocol, no such dialog box appears as the filename is contained in
first block of the data packet.

For ZMODEM, you do not choose receive file command from the menu. This program will automatically 
detect the transfer once the downloading starts.

Once the file transfer starts, you will see a window with the statistics such as file name, total number of 
bytes to receive, number of bytes received etc. You may abort the transfer anytime by clicking on the 
Cancel button.

Sending Files

First you inform the remote system that you wish to upload files. As for the receiving files, you select the 
protocol which matches with the remote system. If you need to send multiple files choose YMODEM 
Batch or ZMODEM protocol. If you have chosen any of these batch protocols a batchlist dialog box would 
be displayed with following controls: 
Done
You click on this button when you are done with creating a batchlist and ready to execute previous 
command.
Delete
You click on this button to delete an entry from the batchlist.
Add
Add button is clicked when you want to add a file entry to the batchlist.

Once you have prepared a list of files to uploaded. Click on the DONE/OK button. Another window would 
appear which shows you the file transfer statistics. If  you wish to abort the transfer then simply click on the
Cancel button. Once your transfer is complete, you will see a message to this effect in the transfer window. 
Click on the OK button to remove the transfer window from the screen. 
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Section Six

Viewing GIF/JPEG File

If you want to view a GIF/JPEG file while downloading it, enable the view GIF/JPEG realtime option from
the utilities menu. Any file of type GIF/JPEG would be displayed on a separate window while being 
downloaded. 

You can also view stored GIF/JPEG files by selecting view GIF/JPEG offline command from the utilities 
menu or from the toolbar. This would activate GIF/JPEG viewer. By choosing "Open" from the file menu 
in GIF/JPEG viewer and selecting file of type GIF/JPG, the file can be viewed.  You can resize the picture 
by selecting stretch/shrink command in the File menu. You exit the GIF/JPEG viewer by choosing "Exit" 
command from the file menu.

UUENCODE

uuencode utility allows you to encode a binary file to an ASCII file so that it can be transmitted on Usenet 
or send as an email on an internet. When you select this option either from the utilities menu or from the 
toolbar, You will be asked for the file name to encode. Select the file and your file be encoded with the 
extension “uue”. If your input file is of large size then the output file is split over into multiple files with 
sequence numbers appended to the file name. The first line of  encoded file contains “begin 600 filename” 
and the last line has an “end”. 

UUDECODE

uudecode utility allows you to decode uuencoded file. Generally on an internet, a uuencoded file is 
transmitted in a batch because of its large size i.e. file a.uue may be transmitted as a1.uue and a2.uue. You 
select this option either from the utilities menu or from the toolbar. You would then be asked for the file 
names which need to be uudecoded. Once you have selected your files, press on the done button and your 
file will be decoded. Make sure that each of the files contain a “begin” at the start of the decoded text and 
an “end” at the end of the decoded text.

Unix to DOS Text File Conversion

This command is executed when you select Unix-to-DOS convert command in the utilities menu. With this 
utility you can convert a text file downloaded from an Unix machine to the MS-DOS format. This utility 
essentially changes the Unix newline character NL (ASCII 10) to CR (ASCII 13) and LF (ASCII 10). The 
DOS file is created with a .DOS extension. This operation can be performed in batch mode.

DOS to Unix Text File Conversion

This command is executed when you select DOS-to-Unix convert command in the utilities menu. With this 
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utility you can convert a text file in the MS-DOS format to Unix format This utility essentially changes the 
CR (ASCII 13) and LF (ASCII 10) characters to single Unix newline character i.e. NL (ASCII 10). The 
Unix file is created with an .UNX extension. This operation can be performed in batch mode.
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Section Seven
Scripts

Editing

Use Edit command in the script menu to call the notepad editor to edit a script file. Here is an example of a 
script file to connect to delphi service via a local sprintnet number: 

All comments in the script file begin with !.

!
! connect to delphi
!
! define timeout for waitstring command. The default is 3 seconds. You may place this 
! timeout anywhere before waitstring command.
timeout 5 
! Transmit string in quotation to remote
send  "@D"
! Wait for string "terminal" from the remote computer
waitstring  "terminal:"
! once it finds string "terminal" it sends a carriage return
send  "^M"
! transmit "c delphi"
send  "c delphi"
! wait for string "username:" from remote"
waitstring "username:"
! Send the username "jjohn"
send "jjohn"
! waits for string "password:" from remote
waitstring "password:"
! sends password "abcdef"
send "abcdef"
! exit from script
exit

Executing Script

Once you have created a script file and you have made an entry of the service in the phonebook, you can 
execute it either from the command execute in the Script menu or by clicking on the Autolog button in the 
phonebook.

Section Eight
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Edit Commands

Copy and Paste

If you want to send the text from the clipboard, first copy the text to the clipboard. This can be done either 
from some other application or from your own screen. You select the text to be copied to the clipboard by 
pressing on the left mouse button and dragging over the text you want copied. Once the text is selected, 
choose copy command from the edit menu. Your text will be copied to the clipboard. Next choose the 
transmit command from the edit menu. Your text will be transmitted.

Clearing Scroll Buffer

When you receive text from the remote computer, this text is placed in a buffer which can be viewed by 
using vertical scroll bar. If you want to clear this buffer, use the clear buffer command from the Edit menu.
Printing

You can print your session log file by selecting print logfile command from the Files menu. You will be 
asked for the file name to printed. Select the desired file and your file would be printed. You can also print 
the saved scroll back buffer by selecting print buffer command from the File menu.

Session Capture

By enabling this option from the session menu, You can redirect all your incoming data from the remote 
system onto to a file for later viewing and printing. Your session log file name would be the name of the 
online service you are  connected to with log extension. You can stop capturing the session by reselecting 
the capture session command from the Options menu.

Miscellaneous Commands

Check Modem Port
This command checks for the port where your modem is connected. 

Break
By selecting this command from the Misc. menu, you would suspend character transmission and place the 
communication device in the break state for 150 ms. 

Communication Status

This dialog box is invoked by selecting comm status from the Misc. menu and it displays the 
communication status. It is an important diagnostic tool if your remote computer is not responding. 
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Following fields are provided:

Transmission is waiting as a result of clear to send signal
If you are using hardware flow control, then this condition indicates that the transmission of your data is 
waiting for clear to send signal.
Transmission is waiting as a result of xoff character being received
This condition would result if you are using xon/xoff flow control and the remote computer sends you a 
xoff character. It can also result if you abort your binary file transfer or as result of garbled character 
received. Clear this box and the transmission would resume.
Number of characters in receive queue
When remote sends you data, this data is placed in a receive queue before being processed by this program.
Number of characters in transmit queue
When you send data to the remote, this data is first placed in the transmit queue and then transmitted If 
your modem or remote is not responding then you would see transmit queue number to increase.
Reset term
When you click on this button, the system will reset the terminal i.e. the scroll region is set to default and 
the xoff flag is cleared.
Switch to MS-DOS

When you select switch to MS-DOS command from the misc. menu, you would switch to MS-DOS. You 
switch back to this program by typing EXIT at the MS-DOS prompt 
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Section Nine
Troubleshooting
Here are some of the most frequently asked question:

Setting problems

Problem
When entering service name in the communication setting dialog box, the system gives an error message 
saying “no service name or invalid service name specified”

Solution
Following characters are not allowed in the name i.e. /, \, [, ],   , |, , <, +, =, ., *, ?. These are the same 
characters not allowed in a DOS file naming convention. 

Problem
When entering phone number and you want non-numeral characters and the system tells you that it is an 
invalid phone number.

Solution
Edit your modem’s string dialog box. There is a field called valid dial characters. You may add any 
characters you want to be included in the phone number field. 

Connecting Problems

Problem
Can not open comm port

Solution
Your comm port may be in use by some other application. Also check the comm port setting in the 
communication setting dialog box. You can find out the ports available in your computer by running a 
program called MSD. See if the assigned port is available in your computer. 

Problem
Can not connect at 14.4K baud.

Solution
This problem is observed with some brand of modems. Try selecting the baud rate of 19200. You would 
still get the carrier of 14.4K but the baud rate between your computer and the modem is set for 19200.

Problem
Can not open communication port for manual dialing or in answerback mode.

Solution
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In the phonebook, make an entry with no phone number field specified and set the phone type field to none.

Problem
No response from modem

Solution
Check your port. In the Misc. menu, select check modem port command. This would tell you which port 
your modem is connected to. Then make this port  selection in the communication setting dialog box. If you
are still experiencing the problem then check your Init string. Consult your modem’s documentation for the 
right Init string. Type in the Init string in the InitString edit box of modem’s setting dialog box. If even this 
fails then check the baud rate. If it is 14.4K then try selecting 19200 as your baud rate in the 
communication setting dialog box.

Problem
After connecting, the program loses the carrier immediately.

Solution
Make sure you set either the hardware (RTS/CTS) or both (hardware & xon/xoff) as your flow control.

Problem
After connecting, garbage characters appear.

Solution
Perhaps, you are connected to 7 databit communication channel. Select 7 databits and even or odd parity in 
the communication parameter dialog box.

File Transfer Problems

Problem
While receiving, if you cancel zmodem file transfer, garbage characters appear and the system stops 
responding.

Solution
Try typing 5 consecutive CTRL-X (control X) characters.

Problem
To many errors while receiving files in zmodem.

Solution
Make sure you are using either the hardware or both (hardware and xon/xoff) flow control. The flow 
control can be set in the terminal preference dialog  box.

GIF/JPEG and uudecode problem

Problem
GIF/JPEG picture colors do not seem to be right
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Solution
Your display card or your display driver may not support 256 colors.

Problem
While uudecoding, system warns of an illegal line number.

Solution
Some uudecoded file lines have an extra character at the end of line. In that case ignore this message. This 
message is also caused when instead of “begin” text at the start of uudecoded text you have some other text
such as section. In that case ignore this message
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